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Introduction 

The URL for this guide is below. As we update this guide, the URL will remain the same. 
(You may want to bookmark this link in your web browser.) 

https://softchalk.atlassian.net/wiki/download/attachments/129237016/quickstartguide.pdf?
api=v2 

 

 

SoftChalk Cloud is the fastest, easiest, most flexible way to create, manage and share your 
digital curriculum content for delivery inside or outside of a Learning Management System 
(LMS).  Using SoftChalk Create, our award-winning content authoring software in SoftChalk 
Cloud, you can create engaging, interactive, media-rich learning content with ease.   

Using this guide, you’ll learn how to quickly create a lesson in your SoftChalk Cloud account 
and then put a link of your lesson into your LMS. Depending on the setup of your LMS, you 
may even be able to capture student scores from your lessons into your LMS gradebook 
using a feature called LTI (see Step 5 in this guide for details). 

Your students will be viewing your lesson in a web browser (all the major browsers are 
supported – e.g. Chrome, Edge, Firefox, Internet Explorer and Safari).  

(If you don’t have an LMS, you can still distribute a hyperlink of your lesson or use the 
ScoreCenter feature within your Cloud account to collect scores.) 

After using this guide, you can get additional instructions on getting started, from the "Get 
Started” page on our website, our Video Tutorials, the SoftChalk Cloud Guide, and the 
Getting Started section in our SoftChalk Create Guide 

Below are the sections in this guide: 

Step 1 - Create a SoftChalk Cloud Account 

Step 2 - Install the SoftChalk Create App 

Step 3 - Create Your First SoftChalk Lesson 

Step 4 - Put a Hyperlink of Your Lesson into Your Learning Management System 

Step 5 - Put an LTI Link of Your Lesson into Your Learning Management System 

Learning Management Systems 

Other Resources and Guides 

https://softchalk.atlassian.net/wiki/download/attachments/129237016/quickstartguide.pdf?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/129237016/quickstartguide.pdf?api=v2
https://www.softchalkcloud.com/
https://softchalk.com/get-started/
https://softchalk.com/get-started/
https://softchalk.com/support/training/video-tutorials/
https://softchalk.atlassian.net/wiki/download/attachments/129404604/cloudguide.pdf?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/129532299/createguide.pdf?api=v2
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Step 1 - Create a SoftChalk Cloud Account 

If you haven’t already created a SoftChalk Cloud account, please use the steps below to 
create an account.   

IMPORTANT: If your institution has an Enterprise SoftChalk Cloud, you will need a 
different SoftChalk Cloud URL and may need different steps to create a SoftChalk Cloud 
account - please consult your institution’s technical support. 

1. Go to https://www.softchalkcloud.com/join 

• If you are creating a “Free Trial” account, please complete the online request form.  
You will receive an activation key via email. 

• If you are creating a licensed account, you will receive an activation key from 
SoftChalk, or from your school/institution liaison. 

2. On the Create My SoftChalk Cloud Account page, paste in the activation key provided 
to you by SoftChalk or by your institution. 
 

3. Fill in the rest of your profile, select the two checkboxes at the bottom and click 
Join.  
 
Congratulations, you now have a SoftChalk Cloud account!  
 
Please see Step 2 – Install the SoftChalk Create App. 

https://www.softchalkcloud.com/join
https://info.softchalk.com/request-30-day-trial
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Step 2 - Install the SoftChalk Create App 

The SoftChalk Create App is the authoring tool you’ll use to create lessons while in 
SoftChalk Cloud.  Follow the instructions below to install the Create App on your Windows or 
Macintosh computer. 

Even if you are not an administrator on your computer, you should be able to install the 
SoftChalk Create App. If you have any questions about computer requirements, please see 
our System Specifications page. If you should happen to run into any issues with your 
installation, please see our FAQs – at the left toward the bottom you’ll see the Installation 
section.  

If you have a Macintosh, please see the section Macintosh on the next page. 

Windows 

1. Download and install the SoftChalk Create App (windows version). 

a. Please be patient while the installer downloads - it typically takes one to five 
minutes. 

2. Open the folder where you saved your installer file. Typically, this folder is called 
Downloads on a Windows computer. The installer file is called SoftChalk-Create-
Cloud-11.exe. Double-click on this file to run the installation.  

3. Congratulations! You have installed the Create App successfully on your computer.  

You’re ready for Step 3 - Create Your First SoftChalk Lesson! 
 

 
 

 

https://softchalk.com/cloud/system-specifications/
https://softchalk.atlassian.net/wiki/spaces/SKB/pages/196182576/SoftChalk+FAQs
https://softchalk.com/create11-installers
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Macintosh 

1. Download and install the SoftChalk Create App (Macintosh version). 

a. Please be patient while the installer downloads - it typically takes one to five 
minutes. 

2. Once the installer has downloaded, Click Open. 

 

3. On your desktop, double-click on the SoftChalk-Create.dmg file (see below). 

 

4. Double-click on the SoftChalk Installer icon (see below) and proceed to the next step 
on the following page. 

 

If you do NOT see the SoftChalk Installer icon above on your desktop, then see the 
following solutions: 

a. Please open your computer icon, typically Macintosh HD. Then look at the 
left hand column under Devices, and click on SoftChalk Installer and 
continue with Step 6 below.  

b. If you do NOT see the SoftChalk Installer icon under the Devices area, then 
you may be using a non-standard program to open .dmg files. Control-click 
on the SoftChalk-Create.dmg file. Choose Open with and make sure that 
DiskImageMounter.app is the selected application. 

https://softchalk.com/create11-installers/
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5. You’ll see the SoftChalk License Agreement: 

 

6. When you click on “Agree” to agree to the license, you’ll see the contents of the disk 
image for the installer.  
 
IMPORTANT: To complete the installation, either drag the SoftChalk.app onto your 
desktop or drag it into your Applications folder. Be sure to close your SoftChalk 
Installer window. 

 

7. Congratulations! You have installed the Create App successfully on your computer. 

 You’re ready for Step 3 - Create Your First SoftChalk Lesson! 
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Step 3 - Create Your First SoftChalk Lesson 

Below are instructions on creating a simple three page lesson with a question, an activity 
and an embedded YouTube video. 

Start SoftChalk Create 

1. Once you have completed the installation of the SoftChalk Create App using the 
steps above, launch Create from your Cloud account: 

a. Login to SoftChalk Cloud with your username and password 

b. From the SoftChalk Cloud menus, choose My Content and then Create 
Content. 

 

c. This will open the SoftChalk Create app and you will be ready to start creating 
a SoftChalk lesson. 

2. The SoftChalk Create app works like a word processing program.  Simply type your 
lesson information into the text area of the SoftChalk Create app. You may also copy 
and paste text into the text area.   

 
 

https://softchalkcloud.com/
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Choose a Theme & Enter a Title 

It’s easy to change the look-and-feel of your lesson – simply select a “Theme” and “Layout”. 

1. In the Create app, go to the Properties menu and select Lesson Properties. 
 

 

2. Choose your ‘Theme’ from the drop-down menu.  Choose your ‘Layout’ from the 
dropdown menu.  You can create your own ‘Theme’ using the ThemeBuilder under 
the Tools menu in Create. For more information on creating your own ‘Theme’, 
please see pages 248-259 of our SoftChalk Create Guide and visit the ThemeBuilder 
video tutorial.  

3. Additionally, you may enter a Lesson Title and Subtitle, and make selections from 
the Navigation, Sidebar, Footer, etc. options that are available on this dialog. 

4. Once you’ve made your selections, click OK.  

 

Preview Your Lesson in a Web Browser 

At any time, you can preview your lesson and see it in a web browser, the way your 
students will see the lesson.  It’s a good idea to preview your lesson often, as you are 
adding and editing content, or modifying your lesson properties. 

https://softchalk.atlassian.net/wiki/download/attachments/129532299/createguide.pdf?api=v2
https://softchalk.com/video-tutorials/style-your-lesson/themebuilder/
https://softchalk.com/video-tutorials/style-your-lesson/themebuilder/
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1. From the toolbar at the top of the Create app, click the View in Browser icon.  You 
may be prompted to Save your lesson.  Then, your web browser will open a new 
window and display your lesson.  After viewing your lesson, close the browser and 
return to the Create app to continue editing your lesson. 

 

 

Add a Question – Example: Multiple Choice 

Adding quiz questions to your lesson is a great way to include formative assessment and 
student feedback into your lesson.   

1. To add a quiz question, press the Enter or Return key on your keyboard to create a 
new paragraph in your lesson text. 

2. Go to the Insert menu in the Create app and select QuizPopper / Multiple 
Choice. Please note there are a variety of questions that you can insert besides 
Multiple Choice. 

3. Type in a question. At the bottom, enter 40 for the points. 

 



SoftChalk LLC copyright 2019 SoftChalk Cloud Quick Start Guide page 11 
 

4. Click the Answers tab. Enter your answers and individual feedback (optional). To 
add another answer, click Add Answer. In the correct column at the left, select the 
correct answer. 

 

5. Click the Display tab at the top. Notice you have three options for how the question 
will be viewed by the student. The default is Embed in lesson page. Click OK. 

6. If you left the default display setting for the Multiple Choice question as embed in 
lesson page, you will see a gray placeholder box. (To edit the question you just 
created, you can right click on this box and choose Modify QuizPopper.) 

7. Click Ok to save your quiz question into your lesson. 

Add a Page Break 

If you have a lot of content in your lesson, you may want to insert page breaks to “chunk” 
your content into multiple pages (rather than delivering all of your content in a single lesson 
page). 

1. In the main editing window, place your cursor in the text where you’d like the page 
to break, then hit your Enter or Return key to create a new paragraph. 

2. Go to the Insert menu at the top and select Page Break / Insert. 
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Add an Activity – Example: Ordering 

Activities are another way to include formative assessment and feedback for your student.  
Some activities can be scored, like a quiz question.  Other activities are “information 
presentation” style activities. 

1. Go to the Insert menu at the top and select Activity / Ordering. (Please note 
there are a variety of activities that you can insert in addition to the ordering 
activity.) 

2. Please note the How To tab, which is available on all activities. You can view an 
example of the activity and a short video on how to create the activity.  

3. Let’s say you want to have students order the first eight planets based on proximity 
to the sun. In the Item area, type Mercury. Then click Add to List. 
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4. In the Item area, type Venus. Then click Add to 
List. 

 

5. Continue adding the other planets. 
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6. Click on the Options tab. At the top in the Instructions for the student, you can 
modify the instructions for your specific activity. 

 

7. For the Activity Display, choose Pop-up from icon. At bottom right, choose 80 for 
the points. Click OK. 

8. In the main editing window, hit your Enter or Return key to create a new paragraph. 
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Embed a YouTube Video 

Using the steps below, you’ll embed the code for a YouTube video within your lesson.  

1. Go to the Tools menu at the top and select Media Search. 

2. In the list at the left, scroll down and select YouTube and click I agree. 

3. At the top, type in a keyword such as algebra and click Search. 

4. From the results list at the right, select an item and click Insert. Click OK at the 
Insert complete window. Click Close to return to your main editing window. 

 

5. In your main editing window, you will see a gray placeholder box for your widget 
(i.e. YouTube video code). To edit the YouTube you just created, you can right click 
on this box and choose Modify Widget.) 
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Save Your Lesson to SoftChalk Cloud 

When you’re finished editing your lesson, you will save it into your SoftChalk Cloud account.   

1. Go to the File menu at the top of the Create app, and select Save to SoftChalk 
Cloud. (If you happen to click the Save icon rather than choosing File / Save to 
SoftChalk Cloud, you would be saving your lesson temporarily on your local 
computer. You will be prompted to save to your lesson permanently before you exit 
the Create program.) 

 

2. Notice the Item Name is the same as the title for the lesson. Choose the folder 
where you’d like to save your lesson.  (The default folder is named Lessons.  You 
can create additional folders as desired.) Click Save. 
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3. You will see a success message once your lesson has been fully uploaded and saved 
to Cloud.  Congratulations you have created your first SoftChalk lesson!   

4. In the Create App, click Close to leave the Save to Cloud window.  

5. To exit the Create App, choose File / Exit. 
 

Lesson Actions in SoftChalk Cloud 

Once you’ve saved a lesson into your SoftChalk Cloud account, you can perform several 
actions – preview the lesson, edit the lesson, and access the lesson link information to put 
into your learning management system.  These actions are described below.  

1. Log into http://www.softchalkcloud.com/. The login link is in the upper right corner. 

2. Select My Content / Lessons. 

 

 

Click on the name of your lesson to display the lesson “detail” page.  (If you have 
multiple folders of lessons, navigate the folders to find the lesson you wish to 
access.) 

3. From the lesson detail page, you can perform several actions – preview the lesson, 
edit the lesson, and locate the lesson link information for sharing your lesson and to 
use with your learning management system.  These actions are described below. 

 

 

http://www.softchalkcloud.com/
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Edit Your Lesson 

If you wish to edit your lesson, from the lesson detail page: 

1. Scroll down to the Lesson Actions area on the right and select Edit Lesson. 

• The first option, Edit in Create, will launch the same Create app you used 
previously to create your lesson.  
 

• The second option, Edit in Create Online, will launch the Create Online 
browser program that allows you to make quick edits to your text. Create 
Online does not have all the features of the Create app you used earlier.  It’s 
an easy way to make quick updates to your content. Make your edits and 
then click the Save icon. 
 

Share Your Lesson 

Each lesson you create in SoftChalk Cloud has its own unique web link (URL).  You can 
provide this web link if you wish students or colleagues to view your lesson.  

1. Scroll down to the Lesson Actions area. At the bottom right, right-click within the 
Hyperlink field and choose Copy to grab a copy of the lesson link. 

2. The next sections will cover the steps for putting lesson links into your learning 
management system.  
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Step 4 - Put a Hyperlink of Your Lesson into Your Learning 
Management System 

There are several options for using your SoftChalk lessons in your learning management 
system.  In this section we describe how to put a hyperlink to your lesson into your learning 
management system course. Use this option if you do not need to collect student scores 
from the lesson into your LMS gradebook. 
 
If you want to collect student scores from your lesson in your LMS gradebook, see the 
section Step 5 – Put an LTI Link of Your Lesson into Your Learning Management System.  
 
If you do NOT have an LMS and want to collect scores, please see the section Track 
Student Scores OUTSIDE an LMS (ScoreCenter) in the SoftChalk Cloud Guide.  

 
1. Scroll down to the Lesson Actions area. At the bottom right, right-click within the 

Hyperlink field and choose Copy (see below) 

 

2. See the section Learning Management Systems for information on putting this link 
into your LMS. You can view a video or follow a guide for instructions - see the 
section Non Scored Lessons in the Guide for your particular Learning Management 
System. 

https://softchalk.atlassian.net/wiki/download/attachments/129404604/cloudguide.pdf?api=v2
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Step 5 - Put an LTI Link of Your Lesson into Your Learning 
Management System 

Your Learning Management System gradebook may be able to accept scores from SoftChalk 
lessons using a feature called LTI. Please contact your institution’s technical support to see 
if LTI has been enabled. If it has, please follow the steps below. 

1. On the lesson detail page in SoftChalk Cloud, scroll down to the Lesson Actions 
area. At the bottom right, right-click within the LTI Link field and choose Copy (see 
below) 

 

2. See the section Learning Management Systems for information on putting this link 
into your LMS. You can view a video or follow a guide for instructions - see the 
section Scored Lessons in the Guide for your particular Learning Management 
System. 
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Learning Management Systems 

As mentioned previously, in order to use the scored lesson feature shown in the Scored 
Lesson Videos below, your LMS administrator needs to enable the LTI feature in your LMS. 
Instructions for the LMS administrator for enabling this LTI feature are found in the guides 
below. Typically, this process takes thirty minutes for the LMS administrator. 

Please contact your institution’s technical support to see if the LTI feature has been 
enabled. 

 

LMS Videos Guide 

Blackboard Non Scored Lesson 

Scored Lesson 

Blackboard and SoftChalk Cloud 
Integration Guide 

BrainHoney Non Scored Lesson 

Scored Lesson 

BrainHoney 

BrightSpace 
by D2L 

Non Scored Lesson 

Scored Lesson 

BrightSpace by D2L 

Canvas Non Scored Lesson 

Scored Lesson 

Canvas (Instructure) 

Jenzabar  Jenzabar eLearning 

Moodle Non Scored Lesson 

Scored Lesson 

Moodle 

Schoology Non Scored Lesson 

Scored Lesson 

 

Schoology 

 
 
 

For additional resources and guides, please see the next section Other Resources and 
Guides. 

https://softchalk.com/video-tutorials/publishing-lessons/publish-to-blackboard/placing-a-softchalk-cloud-lesson-to-blackboard-as-a-non-scored-lesson/
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-blackboard/softchalk-cloud-lesson-to-blackboard-service-pack-10-or-greater-lti-weblink/
https://softchalk.atlassian.net/wiki/download/attachments/121929729/lms_blackboardcloud.pdf?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/121929729/lms_blackboardcloud.pdf?api=v2
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-brainhoney/adding-non-scored-lessons-into-brainhoney/
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-brainhoney/adding-scored-activities-into-brainhoney/
https://softchalk.atlassian.net/wiki/download/attachments/138117122/lms_brainhoney.pdf?api=v2
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-desire2learn/placing-a-softchalk-cloud-lesson-in-desire2learn-using-hyperlink/
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-desire2learn/placing-a-softchalk-cloud-lesson-with-score-center-into-desire2learn/
https://softchalk.atlassian.net/wiki/download/attachments/129402215/lms_brightspace_by_d2l.pdf?api=v2
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-canvas/softchalk-cloud-lessons-placed-in-canvas-as-a-non-scored-item/
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-canvas/placing-a-softchalk-cloud-lesson-into-canvas-using-learning-interoperability-link/
https://softchalk.atlassian.net/wiki/download/attachments/121995266/lms_canvas.pdf?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/129535333/lms_jenzabar.pdf?api=v2
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-moodle/placing-a-softchalk-cloud-lesson-into-moodle-2-2-as-a-non-scored-lesson-using-hyperlink/
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-moodle/placing-a-softchalk-cloud-lesson-into-moodle-2-2-as-a-scored-lesson-using-lti/
https://softchalk.atlassian.net/wiki/download/attachments/129536436/lms_moodle.pdf?api=v2
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-schoology/place-a-non-scored-lesson-link-into-schoology-hyperlink/
https://softchalk.com/video-tutorials/publishing-lessons/publish-to-schoology/placing-a-scored-lesson-into-schoology/
https://softchalk.atlassian.net/wiki/download/attachments/129406952/lms_schoology.pdf?api=v2
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Other Resources and Guides 

Resource Description 

Sample Lessons View sample lessons created by SoftChalk customers. 

Video Tutorials The videos are typically 2-5 minutes long and cover 
Getting Started with SoftChalk Cloud as well as saving a 
lesson to SoftChalk Cloud, using images in SoftChalk, 
and creating quizzes and activities. 

SoftChalk Webinars Sign up for free SoftChalk webinars including 
Introductory Webinars for getting started with SoftChalk 
Cloud. 

SoftChalk Cloud Guide Contains info on how to create a Cloud account, 
collaborate on lessons with other instructors, share 
content and find content to use in our SoftChalk Share 
repository. 

SoftChalk Create Guide Gives details on using SoftChalk Create, our award-
winning content authoring software. SoftChalk Create is 
a feature within your SoftChalk Cloud account. 

Student Guide to SoftChalk 
Lessons 

Contains info for students taking SoftChalk lessons. 
Includes a Troubleshooting section.  

Migration to SoftChalk Cloud If you are already familiar with the desktop version of 
SoftChalk Create and want to start using SoftChalk 
Cloud, this is the guide for you. 

PowerPoint Integration Guide Describes options for incorporating PowerPoint content 
into your SoftChalk lessons 

System Specifications Gives the system specifications for both instructors who 
are creating content (e.g. SoftChalk lessons) and 
students who are viewing SoftChalk lessons in web 
browsers. 

FAQs Frequently Asked Questions 

https://softchalk.com/our-customers/sample-lessons/
https://softchalk.com/support/training/video-tutorials/
https://softchalk.com/learn-more/webinars/
https://softchalk.atlassian.net/wiki/download/attachments/129404604/cloudguide.pdf?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/129532299/createguide.pdf?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/200114368/studentguide.pdf?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/200114368/studentguide.pdf?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/129406657/cloudmigration.pdf?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/129407208/powerpoint.pdf?api=v2
https://softchalk.com/cloud/system-specifications/
https://softchalk.atlassian.net/wiki/spaces/SKB/pages/196182576/SoftChalk+FAQs
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Help 

Please visit our SoftChalk Support webpage. For purchase information, please contact 
sales@softchalk.com.  

Copyright Information 

SoftChalk Cloud Quick Start Guide 
Copyright 2017 2018 2019 SoftChalk LLC 
All Rights Reserved 

https://softchalk.com/support/
mailto:sales@softchalk.com
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